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Subject CP2
CMP Upgrade 2022/23

CMP Upgrade

This CMP Upgrade lists the changes to the Syllabus and the ActEd material since last year that
might realistically affect your chance of success in the exam.  It is produced so that you can
manually amend your 2022 CMP to make it suitable for study for the 2023 exams.  It includes
replacement pages and additional pages where appropriate.

Alternatively, you can buy a full set of up-to-date Course Notes / CMP at a significantly reduced
price if you have previously bought the full-price Course Notes / CMP in this subject.  Please see
our 2023 Student Brochure for more details.

Note that as there is no Core Reading for Subject CP2, the changes are all to the ActEd material.

We only accept the current version of assignments for marking, ie those published for the
sessions leading to the 2023 exams.  If you wish to submit your script for marking but only have
an old version, then you can order the current assignments free of charge if you have purchased
the same assignments in the same subject in a previous year, and have purchased marking for the
2023 session.

This CMP Upgrade contains:

· all significant changes to the Syllabus and ActEd Course Notes

changes to the ActEd Assignments that will make them suitable for study for the 2023 exams.
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0 Changes to the Syllabus

There have not been any changes to the Syllabus Objectives.
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1 Changes to the Course Notes

This section contains all the non-trivial changes to the Course Notes.

Chapter 1

Section 1

A question has been added outlining how to perform a chi-square test.  Replacement pages are
attached.

Chapter 2

Section 1

Section 1.3 has been renamed ‘Stress and scenario testing’ and the content changed.  An
additional section, Section 1.5, has been added.  Replacement pages are attached.

Chapter 3

Section 0

In Section 0.2, the second paragraph has been amended to read:

The audit trails for CP2 projects typically run to 5 or 6 pages and the Excel approach can be quite
restrictive, especially if you want to include special formatting in your work.  It may also be more
difficult to structure the audit trail clearly in Excel.

The following has been added to the fourth paragraph:

It is preferable to have completed most of the modelling and documented all your spreadsheet in
the audit trail than completed the modelling and run out of time to write the audit trail with
sufficient detail.

Chapter 4

Section 4

An additional section on Next Steps has been added.  Replacement pages are attached.
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Chapter 5

Section 2

The information box at the end of Section 2.2 has been deleted and the following text added to
the section:

You can also produce histograms (where the frequencies of the values are represented by the
areas of the bars) and box and whisker plots (showing the variation of the data), automatically in
Excel.

Chapter 6

Section 2

Additional content on the CHISQ.TEST function has been added to Section 2.5.  Replacement
pages are attached.

Practice questions

In Question 6.4, the second chart has been amended as has the solution.  Replacement pages are
attached.

Chapter 7

Section 3

This section has been amended.  Replacement pages are attached.

Chapter 9

Throughout the example project in this chapter, the units have been amended to dollars ($).

Chapter 10

Throughout the example project in this chapter, the units have been amended to dollars ($).
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2 Changes to the X Assignments

Overall

Throughout the assignments, any references to a specific gender have been made gender neutral.

Assignment X2

The currency used throughout has been amended to dollars ($).

Assignment X3

In the marking schedule, in part (iv) the marks available for the ‘peer review model’ next step
have been reduced to ½ mark.
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3 Other tuition services

In addition to the CMP you might find the following services helpful with your study.

3.1 Study material

We also offer the following study material in Subject CP2:

· ASET (ActEd Solutions with Exam Technique) and Mini-ASET

· Mock Exam and AMP (Additional Mock Pack).

For further details on ActEd’s study materials, please refer to the 2023 Student Brochure, which is
available from the ActEd website at ActEd.co.uk.

3.2 Tutorials

We offer the following (face-to-face and/or online) tutorials in Subject CP2:

· a Preparation Day Tutorial

· an Online Classroom.

For further details on ActEd’s tutorials, please refer to our latest Tuition Bulletin, which is available
from the ActEd website at ActEd.co.uk.

3.3 Marking

You can have your attempts at any of our assignments or mock exams marked by ActEd.  When
marking your scripts, we aim to provide specific advice to improve your chances of success in the
exam and to return your scripts as quickly as possible.

For further details on ActEd’s marking services, please refer to the 2023 Student Brochure, which
is available from the ActEd website at ActEd.co.uk.

3.4 Feedback on the study material

ActEd is always pleased to receive feedback from students about any aspect of our study
programmes.  Please let us know if you have any specific comments (eg about certain sections of
the notes or particular questions) or general suggestions about how we can improve the study
material.  We will incorporate as many of your suggestions as we can when we update the course
material each year.

If you have any comments on this course, please send them by email to CP2@bpp.com.
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As an initial check, scanning through the data by eye will usually allow you to spot problems such as 
missing values or repeated values.  However, this may not pick up all the errors, especially if the 
data set is large.  So you should also apply some automated checks using Excel formulae that will 
highlight any errors. 

The summary statistics should highlight any outliers, as these may fall outside the normal range of 
values.  The summary calculations will also throw up an error if you have applied an Excel function 
to data that contains invalid characters – for example, a letter O instead of a zero. 

Try to incorporate some automated checks on the data and include a description of this in the 
audit trail.  For large data sets, automated checks are more reliable than reviewing by eye. 

Document all the data checks you apply and any remedial action you take (even if no remedial 
action is required) and give reasons for your approach. 

However, don’t spend too long working on the data.  It is important to move on to develop the 
rest of the model. 

Another method of checking the data that can sometimes be useful is to plot a graph.  Before you 
create the chart, consider what you are expecting it to show.  This will help you explain why the 
results of the graph are reasonable, or not.  This explanation should be included in your audit trail 
as a reasonableness check on the data. 

Question 

Can you think of a situation where this might be an effective way of identifying data errors? 

Solution 

Plotting a graph can be useful where we have a series of data values that we would expect to show 
a consistent progression – for example, a table of mortality rates plotted against age or the values of 
a financial index plotted against time.  A graph would highlight any spikes or other irregularities that 
might be difficult to spot otherwise. 

 
‘Raw’ data and ‘clean’ data 

It is good practice to keep the original data set intact and work from a ‘copy’ within Excel.  This 
means that if a different, or corrected, data set is used later, it will be possible to compare the 
two data sets. 

Ideally your spreadsheet should show separately the original ‘raw’ data with any warning 
messages from the Excel checks that were applied and the modified ‘clean’ data with the 
corresponding Excel checks now saying ‘OK’. 
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You should link the data in the ‘clean’ data worksheet to the ‘raw’ data worksheet so that if the 
original data changes, the ‘clean’ data will be updated.  Only cells where an amendment to the 
value has been required following the data checks should be hard-coded.  These cells should be 
clearly highlighted. 

How do we fix data errors? 

If you spot a data error that you think would significantly affect the results, you should modify the 
data as you think best, and document clearly in your audit trail what you have done and why.  
Make it clear in ‘clean’ data worksheet what data has changed.  This can be achieved by shading 
the amended cells a different colour. 

We will see an example of this in the Worked Example in Chapter 9, where we have to supply 
some missing data values that were not provided. 

Try to set up your spreadsheet so that any changes made to the data at a later stage (possibly by 
someone else) will automatically be reflected in the subsequent calculations. 

Where possible avoid copying and pasting values since this means that changes to the data will 
not be reflected later in the calculations.  Use cell references instead. 

If, for some reason, you cannot avoid pasting values, document very clearly what you have done 
so that someone else would be able to replicate your work. 

1.3 Validating a data set 

The purpose of validating a data set is to check that the distribution of the values is consistent 
with the statistical distribution that it is assumed to follow.  This can involve checking: 

  the highest and lowest values 

  sample moments, such as the mean and standard deviation 

 charts of the distribution of values. 

It may also be necessary to carry out a chi-square test in order to check the goodness of fit of a 
particular distribution to a data set. 

Question 

Explain how you would carry out a chi-square test to check whether there is a statistical difference 
between a given data set and a given distribution. 

Solution 

The chi-square test aims to test the hypothesis that the data is from the given distribution.  This is 
the null hypothesis. 
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1. Split the actual (observed) data into groups and determine the number of entries in each 
group. 

2. Calculate the number of data entries that would be expected in each group if the data is a 
random sample from the given distribution. 

3. Calculate the following for each group: 

 2O E
E


  

4. Sum the values calculated in stage 3 for all groups.  This is the observed value of the test 
statistic. 

5. Calculate or look up the critical value from the 2  distribution with degrees of freedom 

equal to the number of groups minus 1 at the given significance level eg 5%. 

6. If the observed value of the test statistic is greater than the critical value, there is sufficient 
evidence to reject the null hypothesis at the given significance level and it is reasonable to 
conclude that the data does not come from the given distribution. 

7. If the observed value of the test statistic is smaller than the critical value, there is 
insufficient evidence to reject the null hypothesis and therefore no significant evidence to 
suggest that the data does not come from the given distribution. 

In Excel the function CHISQ.TEST can be used to carry out a chi-square test.  This will be covered in 
more detail in Chapter 6. 

 
We will look at the Excel functions that can be used for validating data in Chapter 6. 

1.4 Extracting the relevant information from a data set 

In some cases you may need to convert the data from its original form.  For example, you might 
need to convert a history of market values of an asset into rates of return or you might need to 
convert dates of birth into ages before proceeding. 

This conversion should be done after you have sorted out any problems with the original data. 
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The chapter summary starts on the next page so that you can 
keep the chapter summaries together for revision purposes. 
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Exam tips 

Be clear what the purpose of the investigation is. 

Make sure you spend sufficient time thinking about the project and planning the model and 
outputs.  The examiners have said that many candidates lose a lot of marks by ‘diving’ straight 
into the project before they have given it enough ‘thinking’ time.  So, get into the habit of 
considering the whole project and planning your model accordingly, so that you don’t fall into this 
trap.  At the start of the exam, identify the key building blocks for the project and to decide on a 
logical sequence for linking these components together. 

Try also to make your model flexible, so that you can easily adapt it to allow for a different data 
set, different parameter inputs or to generate extra results.  This habit will be useful in the office 
as well as in the CP2 exam. 

 

Warning 

Markers have told us that some candidates have tried to use templates from other projects when 
working through the assignments.  This is not allowed in the CP2 exam – each project must be 
started from scratch. 

However, it is a good idea to settle on a preferred style you are comfortable with.  For example, 
how will you set out your tables and what colour scheme will you use?  You should be able to 
develop this as you work through the ActEd Notes and the sample projects.  The presentation 
does not need to be complicated, but if you don’t have to spend time deciding on such issues in 
the exam, you will have more time to focus on the project itself. 

1.3 Stress and scenario testing 

The CP2 exam projects often involve carrying out calculations for different stresses or scenarios, 
ie variations on the original model.  The variations generally relate to the parameters used. 

The output of the model will then consist of a set of parallel results with one for each stress or 
scenario. 

Question 

Give one example of a stress test and one example of a scenario test that could be carried out on 
an asset valuation model. 
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Solution 

Individual stresses could be applied to parameters such as: 

 equity returns 

 interest rates 

 inflation. 

A scenario could be carried out to model the impact of a recession where several parameters are 
all stressed simultaneously. 

 

If the model we are using is a stochastic model, eg a simulation exercise, this will also generate a 
set of scenarios, with one scenario for each simulation run. 

Some students are concerned about what to do if they are not familiar with the mathematical 
content that the exam is based on.  Whilst the exam question should give you all necessary 
formulae, you may find it useful to have some notes from earlier subjects available to you with 
basic formulae, for example interest and annuity rate functions. 

If you do feel ‘stuck’ in the exam, make a reasonable assumption about what is being asked, 
document the assumption, complete the calculation and move on.  At most, you will lose the 
marks for the step of the modelling you did incorrectly.  If you then do the next steps correctly, 
you will not lose any follow-on marks. 

If a result doesn’t look correct, document this in the audit trail.  

1.4 Checks 

As part of the model you should include checks on both the accuracy of results and the 
reasonableness.  The accuracy checks should be automated and included within the model.  There 
is advice in Chapter 6 (Using Excel) on how to carry out these checks.  Reasonableness checks may 
just be documented comments in you audit trail.   

1.5 Updating a model 

In the Paper 2 exam, you will be asked to amend an existing model that you will be provided.  
Common tasks in the Paper 2 exam are: 

 amending existing calculations for changes 

 adding additional scenarios 

 creating tables of results 

 creating charts. 
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It’s important that you make it clear where your changes are so that the examiner can identify 
these easily.  For example, if you need to add additional parameters for a new scenario, colour 
these a different colour to those already in the spreadsheet.  You can also colour the tabs on any 
worksheets that you add to make it clear these are new. 

If you are asked to add calculations to the worksheet you can often start by taking a copy of an 
existing worksheet and then amend the parameters and calculations used as required by the 
question.  Make sure to include checks on your new calculations. 

Creating charts and tables is discussed in more detail in Chapter 5 (Presenting results). 
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The chapter summary starts on the next page so that you can 
keep them together for revision purposes. 
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4 Next steps 

4.1 Exam tips 

The final part of the summary report is to generate ideas for next steps.  Along with the 
commentary on the results, this is one of the parts of the Paper 2 exam worth the highest number 
of marks. 

As mentioned above, a good starting point for your next steps is the commentary on the results.  
In particular, comments related to inferences & implications (INF) may give you ideas of areas that 
could be investigated further.  You can also work through the different areas of the project trying 
to generate relevant next steps related to each area.  For example, work through each 
assumption and try and generate a relevant idea for a next step.   

However you generate the ideas for your next steps, it is important that they are specific to the 
situation in the question.  You won’t score many marks for generic ideas. 

4.2 Generating ideas 

To generate ideas, it is useful to ask yourself questions about the different areas of the project.  
Here are some ideas to start you off, but you may want to expand this list before the exam with 
question and ideas that you find helpful. 

Data 

Is the data reliable? 

Are there any concerns about the accuracy of the data? 

Could we check the data by comparing it to data from another source? 

Could we expand the data or get extra data that might improve the understanding or modelling of 
the situation? 

Assumptions 

For each assumption, is there a way to improve the model so that the assumption is no longer 
required? 

Modelling 

Should any of the parameters be amended?  Could any be made time dependent? 

If the model is deterministic, would it be appropriate to extend it to a stochastic model, what 
would the stochastic parameter(s) be and how would this help the understanding of the 
situation?  
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Could the model be extended to improve the understanding of the situation? 

Are there any alternative scenarios that could be considered?  How would these be useful? 

Do any of the checks indicate that an area could be considered in more detail? 

Comments on the results 

For each result, is there anything else that could be considered to improve the understanding of 
this result? 

Are there any knock-on consequences of the results for the client that could be investigated? 

Question 

Go through the previous question and solution in this chapter and suggest relevant, tailored next 
steps. 

Solution 

Crude rates 

 Verify the numbers of deaths and exposed to risk figures are reasonable compared to 
alternative sources (eg previous internal analysis or external reinsurer data) to give 
confidence regarding the reliability of the data. 

 Investigate mortality during the investigation period to confirm the deviations are due to 
random fluctuation and not caused by any underlying issues (eg pandemic). 

 Compare the crude rate analysis to analysis for the UK to confirm that the pattern of 
mortality is consistent with the larger population over the same period. 

Spline graduation 

 Consider changing the location or number of knots used. 

Graphical graduation 

 Review the results of the graphical graduation to remove the kinks at ages 33 and 45 to 
improve the fit.   

 Consider whether the results of the chi-square tests would be affected if the confidence 
interval was amended, eg 2.5%, or with a different groupings. 

 
As for the comments, you can also use the list at the end of this chapter to help generate ideas for 
next steps. Remember to tailor these to the specific situation in the question and try to generate a 
range of different ideas. 
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Solution 

The formula for calculating  1 22log cos(2 )e u u  would be: 

 = SQRT (–2*LN(RAND( ))) * COS(2*PI( )*RAND( )) 

Excel treats PI like a function.  So you need to include the brackets, even though it is a constant 
and has no arguments.  You could of course simply type 3.142 instead. 

 
Chi-square test 

As mentioned in Chapter 1, there is a specific function within Excel for carrying out a chi-square 
statistical test.  It requires the data to be grouped and the actual (observed) and expected values 
for each group determined.  Once this has been done, the CHISQ.TEST(actual_range, 
expected_range) function can then be used.   

This function returns the probability that the observed and expected data are from the same 
distribution.  For example, a result of 0.97 means there is a strong likelihood that the data are 
related.  A lower value of 0.003 means there is much less change the data are related. 

So, when using the CHISQ.TEST function, if you wanted to perform the test at the 5% level, the 
result of the function should be compared to 5%.  If the result of the function is greater than 0.05 
we will accept the null hypothesis that the observed and expected data are from the same 
distribution.  If it is less than 0.05, it is very unlikely the data are from the same distribution and 
we will reject the null hypothesis. 

2.6 Financial functions 

The following financial functions might prove useful.  For further explanation of the arguments of 
the functions, see the Help pages in Excel. 

NPV(rate, values) gives the net present value of a series of cashflows, discounted at a specified 
interest rate.  The interest rate is the effective rate for the period between cashflows, eg if you 
are discounting annual cashflows then the rate used should be the annual effective rate of 
interest.  Note that this function assumes that cashflows occur at the end of each year/period. 

IRR(values) gives the internal rate of return for a series of cashflows.  If necessary, you can specify 
an initial guess to use (eg 5%) by including this value as a second argument. 

PMT(rate, nper, pv) calculates the repayments required to pay off a loan, where rate is the 
interest rate, nper is the number or repayments and pv is the initial loan amount. 
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2.7 Other useful functions 

Other functions you might need to use are ABS (absolute value), INT (integer part) and ROUND, 
ROUNDDOWN, ROUNDUP, which can be used to round answers to a specified number of digits or 
to restrict the number of significant figures shown. 

Question 

What answers do you think ROUND(12345.6789, 2) and ROUND(12345.6789, –2) would give? 

Solution 

This will round the number 12345.6789 to 2 decimal places (ie to the nearest 0.01), which will give 
12345.68. 

This will round the number 12345.6789 to the nearest 100, which will give 12300. 

 
Note, however, that you should not normally force Excel to round answers in this way.  It is 
usually better just to set the display settings for the cell to display the number of decimals you 
want to show.  Excel will then retain the accurate value ‘behind the scenes’ and use the accurate 
value in any further calculations involving the value in that cell.  

To insert one of the more advanced functions in your spreadsheet, it is usually best to use the 

function icon ( xf ) on the formula bar.  This has the following advantages: 

 it presents you with a list of all the available functions (which is useful if you can’t 
remember the exact name) 

 when you select a function, it describes the arguments of the functions and the order in 
which they appear 

 it allows you to pick out the input values directly from your spreadsheet (click on the icon 
on the right and then select the cell(s) you want using the mouse) 

 it shows you the value based on the arguments you have selected (so that you can see if 
you’ve used the right cells). 

If any less commonly used functions are required in the assessment, eg the factorial function 
FACT, these will be explained in the exam paper. 
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2.8 Data types 

Most of the examples we have seen involved numbers.  This includes percentages, which are 
stored as 0.05 (say) but displayed as 5%.  However, Excel can also work with text (eg the names 
and job titles in column A) and dates. 

Dates are stored as the number of days since 1 January 1900 but can be displayed in various 
formats such as 25-Dec-2018. 

Question 

Give an example of a calculation we might want to do involving dates. 

Solution 

If a person’s date of birth is stored in cell B1, we can calculate their age last birthday today using 
the function = INT ((TODAY( ) – B1)/365.25) and display the answer as a whole number. 
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Chapter 6 Practice Questions 

6.1 The screenshot below shows how an actuary wants to present an Excel table of the price of a 
share on the last trading day of the last 12 months, together with some summary statistics. 

 
 
A student who is new to Excel has set up a version that currently looks like this: 

 
 
(i) Write down the correct formulae that you would use for cells E2, E4 and E5. 

(ii) The student has obtained a different answer in cell E5 from the actuary.  Identify the 
mistake the student has probably made and describe how to resolve it. 

(iii) Identify the problem with the formulae in cells E7 and E8, and describe how to resolve it. 

(iv) Identify the other changes to the appearance of this worksheet that the student will need 
to make to match the actuary’s version, and describe how to do these. 

 Hint: There are 5 of them. 
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6.2 Set up a simple spreadsheet to simulate the total score when two dice are tossed. 

6.3 State four methods you can use to check an answer that you have calculated using a spreadsheet. 

6.4 Suggest at least four ways to improve the effectiveness of each of the following graphs, which 
relate to an insurer’s portfolio of motor insurance policyholders. 
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Chapter 6 Solutions 

6.1 (i) Formulae 

The formulae would be: 

 Cell E2: =COUNT(B$2:B$13) 

 Cell E4:  =MAX(B$2:B$13) 

 Cell E5:  =MIN(B$2:B$13) 

These would also work without the $ signs or with extra $ signs in front of the B’s. 

(ii) Mistake 

The student probably typed the formula in cell E2 as =COUNT(B2:B13), without $ signs, then 
copied it down to cells E4 and E5, and then edited the function name. 

Cell E5 would then contain the formula =COUNT(B5:B16), which refers to the wrong range (and 
excludes the share price of £42.87 in cell B3). 

If they did this, cell E4 would contain the formula =COUNT(B4:B15).  This also refers to the wrong 
range, but would still give the correct answer because the highest value (£47.04 in cell B13) does 
fall within this range. 

(iii) Problem 

The student has probably typed the function names as MEAN and SD, or something similar.  Excel 
does not recognise these functions and so displays this error message. 

The correct functions for the mean and standard deviation are AVERAGE and STDEV.S (or 
STDEV.P). 

(iv) Other changes 

The other cosmetic changes required to match the actuary’s version are: 

 The heading for column A has been right-aligned so that it lines up with the numbers 
shown in the column.  This is done by selecting the cell, then clicking on the right-align 
icon in the Alignment section on the Home menu. 

 Column B has been made wider to accommodate the heading and column C has been 
made narrower.  To adjust the width of column B, click the mouse on the vertical line 
between the B and C at the top of the columns and drag the column boundary to the 
required width. 

 Similarly, column C has been made narrower. 

 To change cells E4 and E5 to currency format you can use the format painter to copy the 
format from one of the cells in column B or you can highlight the cells and select 
‘Currency’ from the drop-down menu in the Number section of the Home menu. 
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 To apply shading to the answers in cells E2, E4, E5, E7 and E8, select each cell and select a 
suitable fill colour using the fill colour (‘paint can’) icon on the Font section of the Home 
menu. 

6.2 Here is one method you could use: 

 

Cells B3 and B4 each contain the formula =1+INT(6*RAND()) 

Cell B5 contains the formula =B3+B4 

 
6.3 You could simply repeat the calculation on your calculator.  This can be useful for satisfying 

yourself that an Excel function works the way you think it does, but it doesn’t leave a ‘written 
record’ for other users to refer to. 

You can include a cell that generates an automatic warning message if a calculated value is 
unreasonable (eg a negative probability) or inconsistent with another value (eg totals don’t 
match). 

You can repeat the calculation using a different Excel function or a different method. 

You can use independent information for corroboration, eg background information given in the 
question. 

6.4 First graph 

 The incorrect spelling of ‘policyholders’ in the title should be corrected. 

 The series names need to be changed from the default settings of Series1 and Series2. 

 Different styles (eg solid and dotted lines) should be used to distinguish the two graphs. 

 The x axis should be labelled. (The values shown probably need to be changed too.) 

 The number of decimals in the y scale should be set to zero (or, if the number of decimals 
shown in the graph is linked to the data values, the number of decimals displayed in the 
data should be changed). 

 The maximum value for the y scale should be set to a smaller value, eg 100. 

Second graph 

 A more appropriate chart type should be used, as it is not at all clear what this chart is 
supposed to be showing. 

 A legend should be included to explain what the data series plotted represents. 

 The title should me moved so that it doesn’t obscure the main part of the chart. 
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 The title should be changed to something shorter. (The introductory words ‘This chart 
shows’ can also be removed. If more explanation is required, this can be provided in a 
separate note below the graph.) 

 Both axes need labels explaining what they show. 

 Units should be included in the axis titles. 

 The minimum value on the x-axis should be set to 0 to remove the negative values.  
(The values displayed on the axis will then show a more sensible progression.) 

 The minor gridlines should be turned off, as these make it harder to see the line being 
plotted. 
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Aligning a whole line of text 

If you want to align a whole line of text, eg to ‘centre’ a title, you can use the left / centre / right 
alignment tools.  (See the screenshot above.) 

Headings 

To separate the sections of your summary (and your audit trail, if you’re using Word), it is 
sufficient just to use headings with bold typeface and/or underlining.  To add these effects, just 
highlight the heading, then click the B or the U symbols on the menu bar, or alternatively, use the 
key combinations [Ctrl]-B and [Ctrl]-U.  If you need to remove one of these features, just repeat 
the same process. 

Bullet points 

Bullet points or numbered points are a good way to present information that has a list structure.  
Use the bullet points icon on the toolbar (which is shown with three squares) to select bullet 
points or the icon with 1/2/3 for numbered points. 

Exam tip 

While a bullet point style is appropriate, you should make sure you use whole sentences 
(subject / verb / object) to make your points, rather than very brief bullets as are often used in 
PowerPoint presentations.  CP2 is an exam in communication, so you need to make your points in 
full, not as a ‘slide show’. 

Page breaks 

To start a section of your summary on a new page, insert the cursor immediately before the 
position where you want the new page to start, then press [Ctrl]-[Enter] or select Insert > Page 
Break from the menu. 
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3 Typing mathematical formulae (‘equations’) and Greek letters 

It’s unlikely that you will need to reproduce any complicated mathematical formulae in your audit 
trail or summary document.  (It’s usually better to explain the methods you’ve used in words.)  
However, in some situations, you might need to type some mathematical symbols or simple 
formulae. 

Inserting symbols 

You can directly insert Greek letters or mathematical equations within Word using the Insert tab 
on the Ribbon.   

Math AutoCorrect 

You can use shortcuts to enter Greek letters and mathematical symbols by turning on ‘Math 
AutoCorrect’.  To do this go to the File menu, open the Options menu, select Proofing from the 
left-hand list and then the button AutoCorrect options.  Choose the tab Math AutoCorrect and 
tick the box at the top to turn this on.  You can see a list of the shortcuts available.  This can be 
quicker if you are familiar with the shortcuts. 

 

 

  


